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Maintaining a Web Site 

The Process 
There is a standard process to follow whenever changes to a web site are needed: 

1. determine location in your site of the page, or pages, to be changed, and for 
each page: 

a. download the latest version of the page(s) from the preview server, 
webdev, to your local computer 

b. make the required changes to the page text and images 
c. upload the changed page back to the preview server, webdev 

2. preview the changed page(s) in your browser and checking all aspects, 
particularly, test all links and ensure the page layouts are correct  

3. after testing, upload the changed page(s) to the live site using the Webaccess tool. 
 
The firsts step is carried out using Dreamweaver to perform both the file management 
functions of downloading and uploading pages to be changed and also the editing 
functions which enable the changes to be made. In addition, Dreamweaver performs 
several other functions, such as ensuring that only one person can edit any particular 
page at one time and always ensuring that the most recent version of a page is the one 
being edited. The second and third steps, preview and upload, repsectively, are 
performed using your browser, usually Netscape Navigator 
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Finding the Page to Edit 
In order to find the page you need to change, it is often easiest to find the page using 
your browser. Once you have found the page you want in your browser, you can use 
the URL determine where to find the page within your site in Dreamweaver. The first 
part of the URL is your site. Any words after that which are followed by a “/” are 
folders within your site. If the URL ends with a “/” sign, the file you are looking for is 
the “index.html” within the folder as this is the default filename. Otherwise, the 
filename should appear at the end of the URL.  
 
As an example, consider the following page in the webstandards site: 
http://www.adelaide.edu.au/webstandards/upload/  
First discard the site part of the (URL http://www.adelaide.edu.au/webstandards/ ) and 
look at what remains. In this instance it is /upload/ therefore the file to be edited will 
be the index.html file within that folder. 
 
However if the URL were: 
http://www.adelaide.edu.au/webstandards/upload/webaccess.html 
the page to be edited would be the file webaccess.html within the /upload/folder. 

Starting Dreamweaver 
To start Dreamweaver, click on the Start button on the taskbar, 
select Programs from the list, 
select Macromedia, 
select Macromedia Dreamweaver MX. 
 
This will open Dreamweaver with a blank untitled web page opened for editing. To 
open a new blank web page at any time, from the File menu, select New Window. 

Optional Windows and Toolbars 

Welcome Overview 
Dreamweaver provides an overview of the software in the form of guided tours and 
tutorials. To access these, click on the Help menu and select Welcome. This will open 
the following window which allows you to select from a number of options: 
 

 

Objects Toolbar 
This toolbar provides shortcuts for adding objects into your web pages. To display the 
objects toolbar, from the Window menu, select Insert. There are a number of 
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variations of this toolbar, depending on what type of entries you are making into your 
webpage, including: 
 

     
 
Which, if any, of these objects boxes you choose will depend on what you are creating 
in your webpage at any one time.  

Site Files 
Dreamweaver allows you to manage the files in your site from the Site files window. 
The Site Files window can be configured to open when Dreamweaver is started. The 
Site Files window displays all the pages in your web site, on your local computer and 
the server, at the same time. From within this window you can also manipulate the 
files in the site, including transferring pages between your local version of the site and 
the live version on the server. The site files looks like: 
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Managing the Site 
 
Use the Site Files window to manage all your uploading and downloading between 
your hard disk and the server. This feature uses FTP to transfer the files but with 
several additional features built in. The Dreamweaver site management window looks 
similar to Windows Explorer and allows you to see the whole structure of your site at 
once. One of the advantages of this site manager is that it maps the site on the server 
to the local site and so always makes sure that the files are put into the correct folder 
on the server.  

Site Management Window 
 

 
 
The icons have the following purpose: 

Site view icons: These two icons allow you to choose the means of displaying 
your site. Use the first icon which corresponds to looking at the site by site 
files. 
Site: This is where you specify the site you are currently connecting to. It is 
also where you can enter new sites connection details. 
Connect: Toggle icon to connect or disconnect to/from the site specified in the 
site field. If the powerplugs are joined and the green light is displayed (as 
shown), the connection to the remote site is active. If the powerplugs are 
separated and the light is not on (black) then there is no connection. 
Refresh: Clicking this icon refreshes, and reorders where necessary, the 
listings of both the local and remote sites. 
Upload/Download: The green arrows get files from the server and put them 
onto your hard disk. The blue arrows move files from your hard disk and put 
them on the server.  

Uploading and Downloading Files 

Get Files 
In general, when you want to download a site or webpage to your hard drive to view it, 
you can use the green arrow to “Get” the file. This will copy the file from the server to 
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your local drive without locking the file on the server to prevent others from accessing 
it. It is recommended that your site is set up to use Check In and Check Out in which 
case a file which you “Get” will be read only on your local drive and you must check 
the file out before it can be edited. 

Put Files 
To copy a file from your local drive to the server without changing its locking status 
on the server, use the plain blue arrow. You would use this upload method if you want 
to preview changes you have made to a file on the server, but are then continuing to 
work on the file and don’t want to unlock it on the server for other users to access it. 

Check In and Check Out Files 
Use the ticked green arrow do download a file you are changing and use the blue 
padlocked arrow to upload the changed file to the server. These are the Check Out and 
Check In buttons which safeguard your site by ensuring that it is always the latest 
version of a file which is edited and preventing more than one person at a time from 
accessing a file to change it. As several people may be working on the site at any one 
time, it is important that a system is in place which only allows one person to edit a 
file at any one time to prevent one person's changes overwriting another's. 

Check Out Files 
To check a file out so that you can edit it, select the file you want to change then click 
the ticked green arrow button to mark the file as checked out to you. This gets the 
current version of the file from the server which has any new updates that someone 
else may have added since you last downloaded the files. The check out option also 
locks the files so that no-one else can make changes to the file until you have finished 
and checked the file back in. 
 
Alternately, you can double click on the file you want to open. When the following 
window appears, click on Check Out to open the file for editing. 
 

 
 
If you do not want to make changes to the file you can click on View to open the file 
for reading only. A third option is to right click on a file, you can select Check Out 
from the menu which appears. 

Check In Files 
To check a file in so that it is free for others to edit, click on the file to select it and 
then click the padlocked blue arrow button. This puts your new changed file on to the 
server and unlocks it for others to use. Note it also makes it read only on your hard 
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disk so you have to check it out again if you want to make further changes. This is to 
ensure that you have the latest version of the file whenever you edit it. 
 
You can also check in a file by right clicking on the file and then selecting Check In 
from the menu which is displayed. 

Undo Check Out 
If you save changes to a file locally and then realise that they are incorrect, you can 
elect to undo the check out. This re-copies the file from the server, causing your 
incorrect changes to be overwritten and allowing you to start afresh with making 
changes to the file.  
 

Editing Pages in Dreamweaver 

The Editing Toolbar 
Most editing functions in Dreamweaver can be carried out from the Properties toolbar. 
If you don't see this floating toolbar when you have a page open, you can display it by 
clicking on Windows from the top menu bar, then selecting Properties.  
The properties toolbar is shown below: 
 

 
 
Each of the fields in the toolbar have the following purpose: 

Format: Allows text to be formatted to pre-defined heading styles. Applies to 
selected paragraph. 
Font: Apply font to selected text - do not use. 
Size: Specify relative size of selected text - do not use. 
Colour: Specify font colour of selected text - do not use. 
Bold: Set selected text in bold type. 
Italic: Set selected text in italics. 
Justify: Left, centre or right justify selected paragraph. 
Link: Create or change a hyperlink on selected text. 
Target: Specify frame for opening link. Use to open a link in a new window. 
Bullets: Set selected paragraphs as bullet or number points. 
Indent/Outdent: Indent or outdent selected paragraph. 

Formatting Text 
Use the format field in the toolbar to format text within the webpage. The formatting 
style is applied to the selected paragraph of text. For body text, this field will be set to 
either Paragraph or None. 
 
In order to specify text as a heading, click anywhere in the line of heading text and 
select one of the heading styles Heading1 to Heading 6 from the drop down list. This 
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will format the text as the appropriate level of heading. To check the way that the 
heading will appear in the live page, you can go to the webguide 
<http://www.adelaide.edu.au/webguide>. 
 
Do not use Font, Size or Colour to format text as these types of formatting are not 
compatible with the style sheets used with the University templates. If they are used, 
they will be stripped from the text when the page is displayed and so the page will not 
have its intended appearance. In addition, they may cause the style sheets to "break", 
stopping any correctly applied heading styles from being applied. 
 
Bold and italics formatting can be applied to selected text for minor headings and 
highlighting within a paragraph. 

Creating and Editing Links 
To create a link, select the text to appear as the hyperlink and then click in the Link 
field. Enter the URL of the link in the entry field. There are several ways of doing this. 
If the link is a link outside the site, type the URL into the link field (you can use cut 
and paste from your browser).  
 
If the link is within your site, you can also use either browse or pointer to enter it. To 
browse, click on the folder icon next to the link field and use the windows browse to 
select the link you require. Alternately, click on the pointer icon next to the link field, 
and holding the pointer down, drag across the file you want to link to in the Site Files 
window and let go of the pointer. Both browse and point will create a relative link, 
that is, the link is made relative to the current page within the file structure. This is the 
recommended way of entering links to pages within your site as it will not cause the 
links to break if the site is moved. 
 
To change a link, click anywhere within the link text and use the same techniques to 
change the link details within the link field. 
 
To delete a link, click anywhere within the link and delete the link details from within 
the link field. 
 
When linking to a page within within the University site, clicking on the link should 
open in the page in the current window. The back button can then be used to move 
back to a previous page if needed. For links outside the University site, the convention 
is to open the link in a new window, leaving the University site open in a the original 
window.  Use the Target field, to the right of the Link field in the properties box, to do 
this. Click the drop-down arrow in the Target field and select the first option _blank 
from the drop-down list. 

Creating Email Links 
 
To create email links, highlight the text to appear as the link and in the link field enter 
mailto:email_address where email_address is the email address to mail to when this 
link is clicked. 
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Creating Anchors 
Anchors are used to jump to a specified point within a webpage. 
 
To create an anchor, go to the point where the anchor is to be set and select Insert 
from the top menu bar, then select Invisible Tags and Named Anchor. Enter a name 
for the anchor. Pressing Control, Alt and A together will also bring up the anchor 
entry window. 
 
You can then create a link to this anchor within the page by typing #anchor_name 
within the link field when creating a link as described above. Alternately, you drag the 
pointer to the anchor which will also insert it as a link. You can also link to an anchor 
in another html page by typing web_page#anchor_name for an anchor set within that 
page. 

Inserting Images 
To insert an image into your web page, first place your web ready image file within 
your local web site on your hard drive, preferably in a folder created specifically for 
storing images. To insert the image click on the Insert Image icon in the objects 
toolbar or go to the Insert menu and select Image. Enter the image file name in the 
pop-up window which is displayed. Make sure that you also upload the image file 
when you upload your webpage. 
 
To wrap text around the image select the Align option of Left or Right, depending on 
which side of the text you want the image to appear. 

Tables 

Insert a Table 
To insert a table click on the Insert Table icon in the objects toolbar or go to the 
Insert menu and select Table. Select the appropriate options for the table in the pop-
up window which is displayed: 
 

 
 
Enter the number of rows and columns and percentage width you require for the table. 
Cell Padding is the space between the border of the cell and the text or images and the 
Cell Spacing is the space between table cells. Either of the following settings work 
well for tables: Border = 1 with Cell Padding = 5 and Cell Spacing = 0, or 
Border = 0 with Cell Padding = 3 and Cell Spacing = 2. 
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Modify Tables 
There are numerous options available for modifying a table within your webpage. 
Some of these options are quickly accessible through the properties box. If a table cell 
is selected, the following options are available in the properties box: 
 

 
 
The table cell options allow you to set the following 

Horz: Horizontal alignment of cell contents 
Vert: Vertical alignment of cell contents 
W: Cell width 
H: Cell height 
No Wrap: If this is selected, contents of the cell will not wrap 
Header: Defines this cell as a header with emphasised formatting. This can be 
applied to any cell(s) in the table 
Bg: Background image. Avoid using. 
Bg: Background colour for the table cell. 
Brdr: Border colour. Avoid using. 

 
If a whole table is selected, the following options are available in the properties box: 
 

 
 
The table options allow you to set the following: 

Table name: Table identifier. 
Rows: Number of rows 
Cols: Number of columns 
W: Table width (in pixels or percent) 
H: Table height 
CellPad: Space between table border and contents. (5 recommended). 
CellSpace: Spacing in border. (0 recommended). 
Align: Horizontal alignment of table, affecting text wrapping around table. 
Border: Border width. 
Bg Color: Table background colour. 
Brdr Color: Border colour. Avoid as this does not display consistently across 
browsers. 
Bg Image: Table background image. Avoid as this does not display 
consistently across browsers. 
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There are a number of other table features which can be changed by selecting Table 
from the Modify menu. 

Saving Webpages 
When you have finished making changes to the webpage you can save changes by 
selecting File and Save from the top menu bar or by closing the file and clicking Yes 
to save changes. 
 
Note that when you save a file the update information which is displayed at the 
bottom of the page will automatically be updated with the current date so that others 
can see the page has changed. 

Creating Pages from Templates 
There are three standard templates available for creating new web pages. These are as 
follows: 
tmpl_1.html: single column format without any navigation, generally used for wide 
tables or front pages. 
tmpl_2.html: the most commonly used format with a left hand navigation area and a 
right hand main page area. 
tmpl_3.html: similar to tmpl_2.html but with an extra column for images or side bar 
information. 
 
To create a new page from the templates, open the templates folder in your local site 
and you will see the three available templates. Click on the appropriate template to 
select it. Copy the template by pressing Control-C or right-clicking the mouse and 
selecting Copy. Go to the folder where you want to create the page and paste the 
template by pressing Control-V or right-clicking the mouse and selecting Paste. 
Rename the template to the required webpage name by right-clicking the mouse and 
typing the name you want for the page. You can then edit this new page as described 
above. Using this process to create new pages from templates will ensure that the 
pages refer to the correct include files such as the navigation files. 

Further Information 

Dreamweaver MX Preferences 
To change Dreamweaver preferences, from the Toolbar select Edit, then select 
Preferences. The windows shown below are the ones for which changes are 
recommended to the standard DreamweaverMX preferences. 
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Show Only Site Window on 
Startup: TICK 
 
Use <strong> and <em> in place of 
<b> and <I>: UNTICK 

Indent: UNTICK 
 
Line Break Type: LF (Unix) 

Rewrite Code: Fix Invalidly Nested 
and Unclosed Tags: UNTICK 
 
Remove Extra Closing Tags: 
UNTICK 
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Extensions: .nav .navinc 
Editors: wordpad (Primary) 
 
Note: To set this preference, click 
the + icon under extensions and 
enter “.nav .navinc” then while 
they are highlighted click the + 
icon under editors and browse 
(usually C:\program files\Windows 
NT\Accessoriewordpad.exe) to 
select the editor  

Note: to change the preference for 
default extension from .htm to 
.html you must edit an external xml 
file. Instructions for doing this are 
available if you click on the link 
document type XML file in the 
DreamweaverMX preferences. 
 

Always Show “Local Files” on the 
“Left”. This option depends on 
user preference. 
 
Dependent Files- Prompt on 
Get/Check Out: UNTICK 
 
Dependent Files- Prompt on 
Put/Check In: UNTICK 
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Setting Up Sites in Dreamweaver MX 
From the Toolbar select Site, then select Edit Sites. Click on the Advanced tab. 
 

 
 
Click New to create a new site, or to change an existing site click on a site to select it 
and the click Edit. Another window will be displayed with several pages of options 
available. Information needs to be entered for the Local Info and Remote Info pages. 

Local InfoWindow 

 
 



DWMX_Training 4/03/2003 14
 

Set the name of the site, which is your name for the site and is not used elsewhere. 
Select a Local Root Folder, which is where the local copies of the files you are editing 
will be stored. This can be anywhere on your local drives and generally a “website” 
folder is set up on the U: drive for this purpose. 

Remote Info Window 

 
 
Set access to FTP and the rest of the window will become available for entry 
Set the host to the appropriate remote server (e. g. webdev.adelaide.edu.au  for the 
university web development machine) 
Set the host directory as appropriate (e. g /adeluweb/site_home/ where site_home is 
the home folder of your site) 
Set the login name and password of the person being granted access. These are the 
LDAP (email) login and password. 
** if the password is not entered here, Dreamweaver will prompt for it when 
connecting. 
Leave the options for Use Passive FTP and Use Firewall unchecked. 
Tick the checkbox for Enable File Check In and Check Out 
This will enable the remaining options to be entered. 
DO NOT tick the option for Check Out Files when Opening 
Enter the name of the person who is being granted access in Check Out Name and 
their Email Address. 
 
Click OK and Done to complete the set-up. 
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Webstandards Guide 
The University of Adelaide web site has a sub site designed to provide information to 
people creating and maintaining web sites within the University. This can be found at:  
• The University of Adelaide Web Standards Guide: 

http://www.adelaide.edu.au/webstandards 
• List of header styles: 

http://www.adelaide.edu.au/webstandards/develop/headings.html 
• Upload information: http://www.adelaide.edu.au/webstandards/upload/ 
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